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General Notes

•	 These instructions are for installing S&G Audit Software (and all associated soft-
ware components) and using it to capture, review, and save audit trail informa-
tion from Sargent & Greenleaf 6126 and 6127 Audit Locks, and 6128 and 6129 
Aseries Locks in Bank Mode.

•  �Software components to be installed include: 
 .NET framework (required to run the SG Audit Software) 
 Crystal Report drivers 
 Touch Key drivers 
 SG Audit Software

•	 The Audit software kit permits the tracking and documenting of lock usage by 
user, operation, time, and date. This information can be archived and/or exported 
in formats that allow it to be integrated with common computer applications for generating reports.

•	 This software will run on computers operating under Windows 7® and Windows XP Pro®.

•	� Transfer of the audit trail information from the lock to your computer is accomplished via Dallas iButton Touch Keys®. This 
eliminates the need for direct physical or electronic connection between the lock and the computer. Audit trails can be 
downloaded at the safe location, then sent anywhere in the world for uploading and analysis. 

•	 Audit trail information is securely encoded when downloaded from the lock to the Dallas iButton Touch Key. It is then 
decoded when uploaded from the key to the computer running the Audit Software.
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Software Installation: 
This section explains the process of installing the SG Audit Software and all of the required components. It includes the  
following components and detailed steps for installing each. Install each software component in the order listed below.
	 • .NET framework (required to run the SG Audit Software)
	 • Crystal Report drivers
	 • Touch key drivers
	 • SG Audit Software

Main Installation Screen
When the SG Audit Software installation CD is inserted into your 
computer, the main installation screen should automatically be 
displayed. If this does not happen, navigate to the CD and run the 
Autorun.exe program.

Selecting Your Operating System
You should first select your operating system from the drop-down 
menu. The available operating systems include Windows XP,  
Windows 7, Windows Server 2003, Windows Server 2008 and  
Windows Vista.

After selecting your operating system, all of the necessary compo-
nents for the software installation will be displayed (yellow buttons).  
The components should be installed in order from top to bottom.  
Simply click on the appropriate button to begin the installation rou-
tine.  Following are detailed installation steps for each components.

	 1. Installing .NET Version 4.0 
	 2. Installing Crystal Reports 13.0 
	 3. Installing the iButton / Touch Key Drivers 
	 4. Installing the SG Audit Software

Installing .NET Version 4.0
The .NET framework contains a set of drivers required to run the SG 
Audit Software. The .NET framework is a standard Microsoft  
component that may already be installed on your system.

1. �Start the installation routine for the SG Audit Software. This 
program should load automatically when the CD is inserted. If not, 
navigate to the CD and run the “Autorun.exe” program.

					     (continued on next page)
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Installing .NET Version 4.0 (continued)
2. �Click the Install .Net Version 4.0 option. 

The files for the installation will be  
automatically extracted to your system.

3. �The license information will be dis-
played first.  If you agree with the 
license, select the I have read and 
ACCEPT the terms of the License 
Agreement option and click the 
Install button to continue. Note 
that if you do not agree to and 
accept the license agreement, this 
software will not be installed.

    �The progress of the installation 
will be displayed.

4. �When the installation has been completed, a window will appear 
confirming the installation.  Click the Finish button to close the 
installation routine.

This will complete the installation for the .NET Framework drivers.  
The SG Audit Software installation menu will be displayed again 
(shown at top of next page).

Please note that you may be asked to restart your system at this time.  
If you do restart your computer, then you will need to run the  
Autorun.exe program from the CD to display the installation menu.
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Installing Crystal Reports 13.0
The following steps outline the installation of the drivers required for 
Crystal Reports. This is the software that is used to generate the  
various reports within SG Audit Software.

1. �Start the installation routine for the SG Audit Software. This 
program should load automatically when the CD is inserted. If not, 
navigate to the CD and run the Autorun.exe program.

2. �Click the option to Install 
Crystal Reports 13.0.

    �When you select this option 
from the menu, a new window 
will appear for the driver in-
stallation for Crystal Reports. 
Simply click Next to continue.

3. �The license information will be displayed next. If you agree with the 
license, select the I accept the License Agreement option and click the 
Next button to continue.  Please note that if you do not agree to and ac-
cept the license agreement, this software will not be installed.

					     (continued on next page)
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Installing Crystal Reports 13.0 (continued)
4. �A new window will appear prompting if 

you are ready to begin the installation. 
Simply click Next to continue.

    �The installation will begin and the 
progress will be shown on the screen.

5. �When the installation routine has completed, then a window will appear 
showing that the installation was successful. Click the Finish button to 
continue.

�This completes the installation for the Crystal Reports drivers. The SG Audit 
Software installation menu will be displayed again (shown at top of  
next page).



page 6

Installing the iButton / Touch Key Drivers
The following steps outline the installation for the touch key drivers.  
These drivers are required to allow communication with the touch 
keys and reader.

1. �Start the installation routine for the SG Audit Software. This 
program should load automatically when the CD is inserted. If not, 
navigate to the CD and run the Autorun.exe program.

2. �Click the option to Install 
Touchkey Drivers. The 
installation routine for the 
touch key drivers will be-
gin.  Click the Next button to 
continue

3. �The license information will be displayed next.  If you agree with 
the license, then select the I accept the terms in the License Agree-
ment option and click the Next button to continue. 
Please note that if you do not agree to and accept the license 
agreement, then this software will not be installed.

					     (continued on next page)
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Installing the iButton / Touch Key Drivers (continued)
4. �The destination screen will be displayed next.  Select the destina-

tion folder for the drivers and click the Next button.  It is suggest-
ed to you simply accept the default values.

5. �A window will appear 
prompting you to  
disconnect all iButton 
readers from the com-
puter before  
continuing.  Please 
remove all adapters and 
then click the Install 
button to continue. The 
installation will begin 
and the status will be 
displayed on the screen.

6. �After the installation has completed, click the Finish button to end 
the install routine.

					     (continued on next page)
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Installing the iButton / Touch Key Drivers (continued)
7. �After you close the touch key driver installation, a window will appear 

instructing you to define the touch key reader type and port.  Click the 
OK button to continue.

8. �Connect the touch key reader to your computer at this time.  The 
computer should notice the new hardware and display the new 
hardware wizard.

9. �Select the option to Install the software automatically and click the 
Next button.

10. �The computer will begin searching for the drivers and should 
automatically find the touch key drivers that were previously 
installed.

      �After the drivers have been found and installed, click the  
Finish button to complete the installation routine.

					     (continued on next page)
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Installing the iButton / Touch Key Drivers (continued)
11. �Verify that the reader can be detected by opening the Auto Detect routine.  This 

is accomplished by selecting START followed by PROGRAMS followed by 1-WIRE 
DRIVERS X64 followed by DEFAULT 1-WIRE NET.

12. ��When the detection routine starts, click the Auto Detect button to begin the 
process.

13. �A window should appear showing that the touch key reader was 
found.  Click the Yes button to save the changes and continue. A 
window will appear showing that the sequence has been completed.  
Click the OK button to continue.

14. �The Default 1-Wire Net installation 
screen will be displayed again.  Simply 
close this window to continue.

      �The touch key drivers should now be 
installed and ready to use with the 
SG Audit Software. The installation 
routine will return to the touch key 
message.  Simply click the OK button 
to close the window and return to the 
main installation screen.



page 10

Installing the SG Audit Software
The SG Audit Software is the main software that is used to add locks 
and review the audit trail information. The following steps outline the 
installation of the SG Audit Software.

1. �Start the installation routine for the SG Audit Software.  This pro-
gram should load automatically when the CD is inserted.  If not, 
navigate to the CD and run the Autorun.exe program.

2. �Click the option to Install Program.

3. �When the installation begins, click the Next button to start the 
install routine

4. �The license information will be displayed next.  If you agree with 
the license, then select the I accept the terms in the license agree-
ment option and click the Next button to continue.  Please note 
that if you do not agree to and accept the license agreement, then 
this software will not be installed.

					     (continued on next page)
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Installing the SG Audit Software (continued)
5. �The customer information will be required next.  Input the  

appropriate information and click the Next button to continue the 
installation.

6. �Select the destination for the installation files and click the  
Install button to continue.

7. �A summary of the installation information will be displayed.  Click 
the Install button to begin the installation of the program files.

8. �The installation status will be displayed on the screen during this 
routine.

					     (continued on next page)
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Installing the SG Audit Software (continued)
9. �Click the Finish button to complete the installation. 

The SG Audit Software should now be installed.

End of Software Installation Section
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Changing Logon Information
1. �When you start the SG Audit Software, you are greeted by 

the screen shown at the right.

Software Operation: 
This section explains how your SG Audit Software works. It will let you perform the following operations:
	 • Clear a Touch Key’s memory 
	 • Format a Touch Key so that it can accept information from a lock 
	 • Upload a new audit trail from a Touch Key 
	 • View, print, and export an existing audit trail file 
	 • Add, delete, or modify lock registrations 
	 • Add, delete, or modify manager registrations

2. �To log on the first time you run the software, use “Adminis-
trator” for the User ID and “password” as the Password. User 
name and password entries are case sensitive.

    Click Ok to bring up the main screen.

3. �To insure the integrity of the audit trail system, you should 
change the User ID and Password immediately. You can also 
add additional managers at the same time.

    �From the View pull down menu, select Manager List.

				    (continued on next page)
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3. �When you click on the Modify button, you are pre-
sented with a screen that allows you to enter new 
User Name and Password information. When you 
have done this, click Save. You can click Close if you 
will not be adding any other managers at this time.

Adding and Deleting Managers
1. �From the View menu on the main screen, select 

Manager List. To add a manager, click Add and 
enter a User Name and Password for the new 
manager. Click Save followed by Close when the 
new entry is complete.

2. �To delete an existing manager entry, click on the 
manager’s User Name line in the Manager List 
to highlight it, then click Delete. Confirm the 
deletion when asked to do so. Note that it is not 
possible to delete all managers and leave the 
software without an administrator.
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Audit Upload Window

Lock Registration—Modify a Lock
From the View menu on the main screen, select 
Upload Audit Trail. You can click on any existing 
entry and Modify to change the information about 
any listed lock.

Lock Registration—Delete a Lock
You can click on any existing entry and Delete to 
completely remove an existing lock’s information.

Lock Registration—Add a Lock
You can create a new SG Audit Lock description by 
clicking the Add button.

About Lock Information Fields
When modifying existing lock information or adding a new lock, 
here’s what you need to know about each data field.

Type of Lock: You can select from 6126/6127 or 6128/6129. This 
refers to the model number of your Sargent & Greenleaf lock. 
Subsequent data entry options are dependent on which set of lock 
models you select.

Description: Enter any description that will help you easily identify 
this particular lock and/or its location.

Lock ID: A unique serial number is provided on each lock body. 
Enter it here.

Daylight Savings Enabled: Check this box if the lock is located in 
an area that observes Daylight Savings Time. Otherwise, leave it 
unchecked.

Programmer/Manager Code (6126/6127 only): Enter the Programmer 
Code or Manager Code that is used to download the audit 
information from this particular lock (see 6126/6127 lock 
operating instructions).

Using with Timelock Keypad (6126/6127 only): If this lock is equipped 
with an optional Timelock Keypad, check this box. Otherwise, 
leave it unchecked. If you check this box and the Timelock 
Keypad is being used in encrypted mode, you must enter the 
8-digit Timelock Keypad serial number. If you are using a  
Timelock Keypad but it is not in encrypted mode, you may enter 
eight zeroes in this box.

PC Code (6128/6129 only): Enter the 6-digit Programmer Code for this 
particular lock (see 6128/6129 lock operating instructions).

Cipher Code (6128/6129 only): Enter the 8-digit Cipher Code that is 
used to download the audit information from this particular lock 
(see 6128/6129 lock operating instructions).

When you have entered the necessary lock information, click Save.
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Touch Key Preparation
The Blue Dot Reader must be attached to a serial port or USB port 
of your computer to perform Touch Key operations.

From the View menu on the main screen, select Upload Audit Trail 
to view the Upload Audit screen.

Before a Touch Key can be used the first time, it must be 
formatted. Snap the key into the Blue Dot Reader. Click Format Key. 
The process takes approximately 30 seconds. Dialog boxes will ask 
you to confirm that you wish to format the key and notify you when 
the format is complete.

If desired, a Touch Key can be cleared (erased). 
Snap the key into the Blue Dot Reader. Click Clear 
Key. This action also takes approximately 30 
seconds. A key does not have to be erased to be 
used for downloading an audit trail. If there is old 
information on the key, it will simply be overwritten 
by the new download. Dialog boxes will ask you to 
confirm that you wish to clear the key and notify you 
when the format is complete.
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Uploading and Saving the Audit Trail
Once an audit trail has been downloaded from a lock into the Touch 
Key, it can be read by the SG Audit Software. Remember that the 
codes in the lock’s registration must match that used in the download 
of the audit trail from the lock.

Snap the key into the Blue Dot Reader. Click Read Key. If the upload 
cannot be accomplished, a dialog box appears to let you know that no 
usable data could be located on the key. Check the registered code 
information to make sure it matches what was used to download the 
audit trail from the lock. Try to read the audit trail again. If problems 
persist, use a different Touch Key, and check to make sure the time 
and date have been programmed into the lock.

When the upload is successful, the Read Key Complete! dialog box 
will appear. The upload process takes about 30 seconds.

If you are going to save the audit trail data, this is an excellent time 
to do it. Once the software has captured an audit trail, the Save Data 
button becomes usable. Click on it, and the audit trail information 
will be saved and cataloged by description, lock ID, time, and date. A 
dialog box will appear when the save operation is complete.

Managing Audit Report Information
Select View Previous Audit Uploads, under the Reports menu 
found on the main page.

You can delete saved audit reports or change the  
descriptive information (Description, Lock ID, Date/Time) 
associated with the report by selecting the row containing 
the report you wish to delete or modify, then clicking on the 
appropriate button to the right of the reports list (Delete 
or Modify).

All saved reports can be viewed at any time by selecting the 
row containing the report you wish to view and clicking the 
Report button. You can select a particular PIN position (code 
holder) to view in the report, ignoring all others. If you leave 
the selector box set to ALL, all PIN positions (code holders) 
will be included in the report.

				    (continued on next page)
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Managing Audit Report Information (continued)
When you click on the Report button, the audit trail 
information will be displayed. The menus at the top 
of the window will let you view, manipulate, print, and 
save audit report information in a number of formats.

Audit trail information is displayed with the most 
recent activity at the top of the page, followed by 
the next most recent event, and so on. Each event 
is sequentially numbered and matched with a result, 
the time and date of the attempted action, and which 
user attempted the action. By knowing who the User 
Number was assigned to, you can identify the person 
performing the operation.

It should be noted that an entry stating “Bolt did not 
retract” could mean the battery was too low to open 
the lock, there was excessive side pressure on the 
bolt, or there was some mechanical issue preventing 
the lock bolt from retracting.

Any events captured by the lock prior to the time and 
date being set will have the date 1/1/00 assigned to 
them.

Software Version
When checking for upgrades or speaking with a technical service representative about operating issues, you may find it helpful 
to know the software’s version number. From the Help menu on the main page select About.


